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1. Bendroji programos apžvalga  

 

1.1 Apie programą  

 

Hot Potatoes – įrankių programa-terpė, suteikianti mokytojams, neţinantiems 
programavimo kalbų, galimybę savarankiškai kurti interaktyvias uţduotis be 
programuotojų specialistų pagalbos.  

 
Programos pagalba galima sukurti 10 skirtingų rūšių uţduočių įvairiomis kalbomis, 

įvairiems mokslo dalykams, naudojant tekstinę, grafinę, audio ir video medţiagas.  
 
Šios programos ypatumas – sukurtų uţduočių išsaugojimas standartiniame 

internetinio puslapio formate: norint pasinaudoti jomis, mokiniams reikia turėti tiktai 
internetinę naršyklę (pvz., Internet Explorer); todėl mokiniams nereikalinga programa 
Hot Potatoes: ji reikalinga tik mokytojams tam, kad kurtų ir redaguotų uţduotis. 

 
Programa plačiai naudojama visame pasaulyje įvairių dalykų mokomųjų uţduočių 

kūrimui. 

1.2 Programos autoriai 

 

Programa buvo kuriama 1997-2003 metais humanitarinio švietimo informacinių 
technologijų centre Viktorijos universitete, Kanadoje (http://web.uvic.ca/hcmc). 

 
Programos autoriai:  
Stewart Arneil – HTML, JavaScript, programavimas Macintosh aplinkai 
Martin Holmes – HTML, JavaScript, programavimas Windows aplinkai 

(http://www.mholmes.com) 
Hilary Street (kompanija «Interdesign Media») – grafika.  
 
Martin Holmes paskutines 6 versijos, išleistos spalio 2003 metais, autorius.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

../Local%20Settings/Application%20Data/Microsoft/Word/(http:/web.uvic.ca/hcmc
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1.3 Programos struktūra 

 
Uţduotys sudaromos su 5 programų blokais (kiekvienas blokas – atskira savaran-

kiška programa): 
 

 
 
1. JQuiz – Klausimynas (4 rūšių uţduotys). 
2. JCloze – Praleistų ţodţių įrašymas. 
3. JMatch – Atitikmenų porų išdėliojimas (3 rūšių uţduotis). 
4. JCross – Kryţiaţodis. 
5. JMix – Ţodţių eiliškumo sakinyje nustatymas. 
 
Visos uţduotys atliekamos treniruotės reţimu (testavimo reţimas numatytas tiktai 

klausimams, turintiems keletą teisingų atsakymų). Uţduoties atlikimo rezultatas apskai-
čiuojamas procentais. Nesėkmingi bandymai sumaţina atliktos uţduoties įvertinimą. 

 
Programos šeštoji versija taip pat turi papildomą bloką «Masher» (Įrankiai), kuris 

leidţia sujungti sukurtas uţduotis ir kitą mokomąją medţiagą į teminius blokus, 
pamokas ir mokomuosius kursus.  

 

1.4 Programos kaina ir naudojimo sąlygas 

 
Programa siūloma nemokamai (laikantis tam tikrų sąlygų) ir mokamai. 
 
Nemokamai programa gali būti naudojama valstybinėse nekomercinėse švietimo 

įstaigose su sąlyga, kad sukurta programos pagalba mokomoji medžiaga bus 
laisvai platinama Internete. 

 
Programos blokas «Įrankiai» yra mokamas – jis perkamas ir registruojamas 

atskirai nuo programos. 
 
Programa mokama yra: 
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1. Komercinėms švietimo įstaigoms. 
2. Jeigu imamas mokestis uţ pasinaudojimą sukurta medţiaga. 
3. Jeigu kokiu nors būdu apribojamas priėjimas prie medţiagos (vienintelis galimas 

apribojimas – slaptaţodţio naudojimas, patalpinant uţduotis į tinklalapį 
(www.hotpotatoes.net)). 

4. Programos papildomo bloko «Įrankiai» visų galimybių panaudojimas. 
  
 Programos platinimu, komerciniais klausimais, uţsiima Half-Baked Software Inc. 

kompanija (http://www.halfbakedsoftware.com). 
 

1.5 Techniniai r programiniai reikalavimai 

 
Kuriant užduotis Windows aplinkoje reikalinga: 
 

 Operacinė sistema Windows 98, ME, NT4, 2000 arba XP; 
 

 Paskutinės versijos vienos iš internetinės naršyklės Internet Explorer 6+, 
Netscape 7+, Mozilla 1.4+, FireBird 0.7, ir kt. 

 
 Norint patalpinti sukurtos programos pagalba uţduotis tinklalapyje, reikalingas 

pagrindinis kompiuteris (serveris) (jeigu jūs norite, kad sukurtos uţduotys būtų 
patalpintos Internete) arba prieiga prie Interneto www.hotpotatoes.net (patalpinimo 
sąlygos yra išvardintos šiame tinklalapio skyriuje  «General Introduction and help»). 
 

Mokinių darbui reikalinga tiktai Internetinė naršyklė. Pati programa mokiniams 
NEREIKALINGA. 

1.6 Programos diegimas 

 
Programą galima nukopijuoti iš pagrindinio Internetinės svetainės puslapio 

http://web.uvic.ca/hrd/hotpot  
 

 

http://www.hotpotatoes.net/
http://www.halfbakedsoftware.com/
http://web.uvic.ca/hrd/hotpot
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Skyriuje «Downloads» (Atsiųsti) pasirinkus nuorodą Hot Potatoes for Windows 
98/ME/NT4/2000/XP (version 6.0.3, self-extracting, auto-installing zip file) programa 
kopijuojama į aplankalą Hotpot 6.0, kuriame yra trys bylos: 
 

 
 

Programai įdiegti reikia atidaryti bylą „setup” (du kartus spustelkite kairįjį pelės 
mygtuką) ir sekti programos diegimo instrukciją. Įdiegiant programą, visos bylos 
kopijuojamos į programos aplankalą, jokių  įdiegimų sistemos lygmenyje nevyksta. 

Norint pašalinti programą, naudojama standartinė programų pašalinimo procedūra 
(Pradėti → Parametrai →  Valdymo skydas → Pridėti arba šalinti programą ). 
 

 
 

http://web.uvic.ca/hrd/halfbaked/winhotpot60.exe
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1.7 Programos registracija 

 
Programos registracija nemokama.  
 
Neregistruota programos kopija turi apribotas galimybes (pvz., galima sukurti ne 

daugiau nei 2 klausimus uţduotyje ir t.t.); 
 
Registruota kopija suteikia galimybę  ne tik naudoti visas programos funkcijas, 

bet ir (išskyrus bloką «Įrankiai») laiku gauti papildomą informaciją apie naujas 
programos versijas. 

 

Uţregistruoti programą galima internetinio tinklalapio registracijos puslapyje. 
Registracijos puslapį galima pasiekti:  

 
1. pagrindiniame programos tinklalapio puslapyje;  
2. šiuo adresu: http://web.uvic.ca/hrd/hotpot/register.htm; 
3. po programos įdiegimo – pagrindiniame meniu. 
 
Tam reikia: 
 

 paleisti programą (Pradėti → Programos →  Hot Potatoes); 

 atversti meniu  «Help» (Ţinynas) ir jame pasirinkti komandą «Register» 

(Registracija); 

 dialogo lange «Register» (Registracija) paspausti mygtuką «Get a key» 
(Gauti registracijos kodą); 

 
* Jeigu su vienu kompiuteriu dirbs keletas vartotojų, reikia pažymėti  (t.y. spragtelti  

kairijį pelės klavišą tuščiame langelyje  – jame atsiras varnelė) šalia sakinio  «I am a 

network administrator …» (Visų šio kompiuterio vartotojų registracija). 

 

 

 

 uţpildyti tinklalapyje registracijos formą (būtinai patikrinama ar jūs 
perskaitėte licenzijos sąlygas).  

 

http://web.uvic.ca/hrd/hotpot/register.htm
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* Jeigu jūs nenorite gauti papildomos informacijos apie programą, pažymėkite atitin-

kamą vietą formoje. 

Po to, kai jūs gausite elektroniniu paštu vartotojo vardą ir registracijos kodą, 
reikia: 

 paleisti programą; 
 
 atversti meniu «Help» (Ţinynas) ir jame išsirinkti komandą «Register» 

(Registracija) ir įrašyti gautą vardą ir registracijos kodą. 
 
Po registracijos meniu «Help» (Ţinynas) nеbus komandos «Register» (regist-

racija), o komandoje «About» (Apie programą) bus parodytas programą uţregistravusio 
vartotojo vardas. 

 

 
 

1.8 Interaktyvus vadovėlis apmokantis dirbti su programa  

 
Tiems, kurie pirmą kartą pradeda dirbti su programa, jos kūrėjai paruošė 

interaktyvų vadovėlį anglų kalba; dirbant su juo galima atlikti uţduotis, sukurtas  
programos pagalba, ir taip pat savarankiškai sukurti vieną iš uţduočių. 

 
Vadovėlis atidaromas taip: «Help» (Ţinynas) – «Tutorial» (Vadovėlis). 
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1.9 Įvairių kalbų panaudojimas  

 
Užduočių kalba (uţduočių tekstai, pratybų aprašymai ir grįţtamasis ryšys) – bet  

kurių atitinkančių UNIC (Jungtinių tautų informacijos centro) kodų standartams. 
 
Programos sąsajos kalba, pagal numatytos programos nustatymus - anglų. Kitą 

kalbą galima pasirinkti pirmą kartą paleidţiant programą arba, bet kokiu momentu, 
atidarius bylą su programos sąsajos vertimu ir pasirinkti norimą kalbą: meniu «Options» 
(Parinktis) – «Load interface file» (Įkelti programinės sąsajos bylą).  

 

 
 
Atkūrimas pradinės (angliškos) programinės sąsajos atliekamas su meniu 

«Options» (Parinktis) pagalba – «Reset Default Interface» (Atkurti pradinę programinės 
sąsajos kalbą). 

 
 

 
 
Galima taip pat sukurti savo programinės sąsajos vertimą, atidarius langą  

«Translate the interface» (Išversti programinę sąsają) tame pačiame meniu «Options» 
(Parinktis).  

Septintoje versijoje autoriai planuoja galimybę nustatyti programinės sąsajos 
kalbą. 
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2. Užduočių kūrimas  

 

2.1 Pagrindiniai etapai 

 
Uţduoties kūrimas susidaro iš kelių etapų: 
 

1. duomenų įvedimas; 
 

2. uţduoties konfigūracijos nustatymas (daugiau apie konfigūracijos 
nustatymą ţr. skyriuje 2.2); 

 
3. uţduoties duomenų pertvarkymas į internetinio puslapio formatą (HTML) – 

tolimesniam mokinių darbui ir uţduoties išsaugojimui; 
 

4. uţduoties duomenų bylos išsaugojimas atitinkamoje programos bloko 
formoje (tam, kad vėliau galima būtų atlikti pakeitimus). 

 
Be to, sukurtas uţduotis  ir atsakymus galima:  
 

 atspausdinti (daugiau apie užduoties spausdinimą žr. skyriuose 2.5. и 

3.4.); 

 apjungti į teminius blokus ir pamokas (daugiau apie užduočių apjungimą 

žr. skyriuose 2.6. и 5). 

2.2 Įrankių juostos mygtukų paskirtis 

 
Su įrankių juostos mygtukų pagalba galima atlikti uţduočių kūrimo pagrindinių 

operacijų, esančių skirtingose programos meniu komandose, greitą paleidimą: 
 
1. uţduoties teksto redagavimas – «Edit» (Taisyti) – standartinės komandos: 

«cut» (iškirpti), «copy» (kopijuoti), «paste» (įdėti), «delete» (šalinti); 
 
2. uţduoties konfigūracijos nustatymai – «Options» (Parinktys) – «Configure 

output» (Uţduoties konfigūracijos išvedimas); 
 

3. duomenų pertvarkymas į Internetinį puslapį (uţduoties įrašymas  ir perţiūra) – 
«File» (Byla) – «Create Web-page» (Sukurti internetinį puslapį) – «Web-page 
for v6 browsers» (Internetinį puslapį tinkama perţiūrėti 6 versijoje); 

 
4. bylos duomenų įrašymas – «File» (Byla) – «Save» (Įrašyti); 

 
5. išėjimas iš programos «Exit» (Išėjimas),  
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o taip pat keletas papildomų funkcijų: 
 

6. duomenų bylos įrašymas kitu vardu «Save as» (Įrašyti kaip); 
 
7. teksto įterpimas į uţduotį «Add reading text» (Įterpti tekstą); 
 
8. egzistuojančios uţduoties duomenų bylos atidarymas «Open» (Atverti); 
 
9. naujos uţduoties sukūrimas tame pačiame programos bloke «New» (Naujas); 
 
10.  ţinynas – «Help».  

 
 
 

 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
Be to, keliuose programos blokuose į įrankių juostą patalpinami ir kiti mygtukai, 

padedantys greitai atlikti operacijas, tam tikroms uţduotims sukurti (pvz., automatinis 
kryţiaţodţio tinklo sudarymas bloke JCross, uţduočių atlikimas su pelės perkėlimo 
pagalba bloke JMatch, įterpimas hipernuorodų, paveikslėlių, objektų ir t.t.). 

 

2.3 Duomenų įterpimas 

 
1. Paleisti programą Hot Potatoes; 

 
2. pasirinkti reikiamos programos bloko ţenklą („bulvė“) ekrane, arba iš meniu 

«Potatoes» (Bulvės); 
 

6. Išsaugoti bylą 

kitu vardu 

1. Užduoties teksto 

redagavimas 

2. Pakeisti 

konfigūraciją 

10. _Žinynas 

9. Sukurti naują 

užduotį  

8. Atverti 

duomenų bylą  

4.   Bylos    

įrašymas 
3. Pertvarkyti  į 

internetinį puslapį 

(užduoties bylą) 

5. Išėjimas iš 

programos 

 

7. Įterpti tekstą į 

užduotį 
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3. įterpti tekstinę uţduoties medţiagą, o taip pat papildomus tekstus, nuorodas ir 
iliustruojančias medţiagas (paveikslėliai,garsas, filmuota medţiaga) į išrinkto 
bloko darbo sritį. Uţduočių tekstus galima įterpti klaviatūros pagalba arba 
nukopijuojant iš paruoštų bylų;  
 

        *Medžiagų elektroninės kopijos žymiai palengvina užduočių kūrimą. 

 
4. esant reikalui, įterpti pataisymus į uţduoties konfigūracijos nustatymus. 

 
Detalios instrukcijos apie darbą su kiekvienų užduočių tipu pateikiamos 

skyriuje 3.  

JCloze – pra- 
leistų ţodţių 
įrašymas  
 

JMix –  ţodţių 
eiliškumo sakinyje 
nustatymas 

JMatch – 
atitikmenų porų 
išdėliojimas 
  

JQuiz – 
klausimynas 

JCross – 
kryţiaţodis 

The Masher –  
Įrankiai 
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2.4 Konfigūracijos nustatymai 

 
Programoje numatyta galimybė papildomam uţduočių konfigūracijų nustatymui, 

kuriame yra bendri ir papildomi, atitinkantys kiekvienos uţduoties ypatybes, aprašymai. 
 
Įjungti konfigūracijos nustatymo reţimą galima su meniu «Options» (Parinktis) – 

komandos «Configure Output» (Konfigūracijos išvedimas) arba atitinkamu mygtuku 
įrankių juostoje.  
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Daţniausiai naudojami bendri visoms užduotims nustatymai leidţia pakeisti: 
 

 pavadinimus ir uţduočių instrukcijas (kortelė Title/Instructions); 
 pagalbos ir atsakomojo ryšio tekstus (kortelė Prompts/Feedback); 
 mygtukų pavadinimus ir jų panaudojimą/nepanaudojimą uţduotyje 

(kortelė Buttons); 

 uţduočių apipavidalinimus – šriftą, fono ir teksto spalvą, ir t.t. (kortelė 
Appearance); 

 chronometro, apribojančio uţduoties atlikimo laiką, nustatymą (kortelė 
Timer). 
 
Papildomi pakeitimai, kaip taisyklė, patalpinti lange kortelės «Other» (Kitas). 
 

*Kortelės «Custom» ir «CGI» skirti darbui vartotojams turintiems daugiau patirties.  
 
Teksto nustatymų didţioji dalis (uţduočių pavadinimai, uţduočių instrukcijos, 

atsakomojo ryšio tekstai, navigacijos mygtukų pavadinimai ir t.t.) jau įvesta anglų 
kalba; esant reikalui, jas galima pakeisti mokinių gimtosios kalbos tekstais. 

2.4.1 Užduočių apipavidalinimas  

 
Daţniausiai pakeičiamos uţduoties apipavidalinimo spalvos su kortelės 

«Appearance» (Išvaizda) pagalba, nes pagal išankstinius programos nustatymus  
puslapio spalva yra balta, teksto fonas pilkas ir spalvos šriftas juodas. 

 
Kiekvienos uţduoties elemento spalva kuriama standartinės spalvų paletės  pa-

galba, kuri pasirodo mygtuko, esančio šalia reikiamo elemento lauko, paspaudimu  
(lauke spalva paţymėta skaičių kodu). Visi atlikti pakeitimai iškart pasirodo uţduoties 
maketo ekrane kairioje konfigūracijų nustatymo lango dalyje:  
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Konfigūracijos pakeitimus galima panaudoti tiktai šiai uţduočiai – tam reikia 

paspausti mygtuką «OK».  
Tam, kad panaudotume sukurtą konfigūraciją kitose programos uţduotyse, reikia 

išsaugoti konfigūracijos bylą – mygtukas «Save» (Įrašyti) ir «Save as» (Įrašyti kaip), o 
po to ją įkelti – mygtukas «Load» (Įkelti) lange «Configuration file» ( Konfigūracijos 
byla). 

 

2.4.2 Chronometro nustatymas  

 
Norint apriboti uţduoties atlikimo laiką, reikia konfigūracijos nustatymo byloje:   

 pasirinkti kortelę «Timer» (Chronometras); 
 

navigacijos 
juosta 

Ekrano fonas 

pavadinimas 

Uţduoties 
fonas 

 

nuoroda 
 
 

 
Aplankyta 
nuoroda 

 

 

tekstas 
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 skyriuje «Time limit» (Laiko apribojimas) paţymėti langelį «Set a time limit 
for this exercise» («Nustatyti šios uţduoties atlikimo laiko apribojimą ») varnele;  

 įrašyti  laiko parodymus minutėmis ir/arba sekundėmis;  
 įrašyti į lauką «You time is over» (Jūsų laikas pasibaigė) sakinį, kuris 

praneštų mokiniui, kad uţduoties atlikimo laikas pasibaigė. 
 

 jeigu mokinys nespėjo atlikti užduotie per nustatytą užduoties atlikimo  laiką,  

užduotis paleidžiama iš naujo ir atliekama iš pradžių. 

 

2.4.3 Paveikslėlių įterpimas 

 

Norint įterpti paveikslėlius į uţduotį, reikia: 
1. Atidaryti meniu «Insert» (Įterpti) ir parinkti komandą «Picture» (Paveikslėlis), 

paskui «Picture from Web URL» (Paveikslėlis pagal ţiniatinklio URL adresą) arba 
«Picture from Local File» (Paveikslėlis iš bylos esančios kompiuteryje): 
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2. Pasirinkus pirmą komandą, atsidaro dialogo langas «Insert an image though a 
URL»: 

 

 
 

šiame lange jus galėsite nustatyti paveikslėlio padėtį uţduotyje. Laukelyje «Picture 
alignment» (Paveikslėlio lygiuotė) paţymėjus akute «Left» (Kairysis) įterptas 
paveikslėlis bus lygiuojamas pagal kairįjį kraštą, «Center» (Centruoti), paveikslėlis 
bus centruojamas,  «Right» (Dešinysis), paveikslėlis bus lygiuojamas pagal dešinįjį 
kraštą, « [None] », paveikslėlis nebus lygiuojamas.  Pasirinkus paveikslėlį 
laukeliuose «Widht» (Plotis) ir «Height» (Aukštis), galima redaguoti paveikslėlio 
dydį. Laukelyje «Alt text» (Alternatyvos tekstas), pasirodo tekstas, apibūdinantis 
paveikslėlį, laukelyje «Link URL» (Nuoroda į URL adresą) - paveikslėlio internetinis 
adresas, o laukelyje «Title» (Pavadinimas) – paveikslėlio pavadinimas. 
   
3. Pasirinkus antrąją komandą, atsidaro dialogo langas «Open» (Atidaryti): 
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jame reikia nurodyti norimo paveikslėlio vietą ir paspausti klavišą «Open» 
(Atidaryti). 
 

 
 

Meniu «Insert» (Įterpimas) padeda jums sukurti paveikslėlio HTML kodą jūsų puslapiui, 

todėl  paveikslėlio jūs nematysite, matysite tik jo kodą. Taip pat atkreipkite dėmesį, kad 

programa automatiškai sukuria priėjimo prie bylos tiesioginį kelią tarp jūsų duomenų bylų 

(jūsų jqs., jcl. ir kitu Hot Potatoes programos bylų)  ir paveikslėlių bylų, esančių jūsų 

kompiuterio kietajame diske.  

2.4.4 Nuorodų įterpimas 

 

Jūs norite įterpti savo uţduotyje nuorodą į internetinį puslapį.  
 
Norint įterpti nuorodą į uţduotį, reikia: 
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1. Atidaryti meniu «Insert» (Įterpti) ir parinkti komandą «Link» (Nuoroda), paskui 
«Link to Web URL» (Nuoroda į ţiniatinklio URL adresą) arba «Link to Local File» 
(Nuoroda į bylą, esančią kompiuteryje):  

 

 
 
2. Pasirinkus pirmąją komandą, atsidaro dialogo langas «Insert Link» (Nuorodos 

įterpimas): 
 

 
  

3. Pasirinkus antrąją komandą, atsidaro dialogo langas «Open» (Atidaryti): 
 

 
 
Norėdami įterpti į savo dokumentą, pvz. garsą, filmuotą medţiagą, galite 
pasinaudoti nuorodomis. 
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2.4.5 Garso ir filmuotos medžiagos įterpimas 

 
Vis labiau populiarėja garso ir filmuotos, ypač mokomosios medţiagos, įterpimas į 
internetinius puslapius. Egzistuoja du pagrindiniai būdai tai padaryti: objekto įterpimas 
ir nuorodos patalpinimas. Antras būdas yra paprasčiausias.  Jį mes ir nagrinėsime šiame 
skyrelyje.  
 
Garso ir filmuotos medţiagos įterpimas iš esmės niekuo nesiskiria nuo nuorodos į bylą 
įterpimo; garso ir filmuotos medţiagos bylos niekuo nesiskiria nuo įprastų bylų. Yra 
kelėtas pagrindinių rekomendacijų ir scenarijaus pavyzdţių.  
 

1. Pradţioje sukurkite savo medijos bylas. Hot Potatoes neturi jokių 
instrumentinių įrankių garso ir filmuotos medţiagos sukūrimui ir redagavimui, 
todėl medijos byloms sukurti turite pasiieškoti kitų tam skirtų programų.  

 
2. Nuorodos į paprastas garso bylas. Tarkime, jūs turite MP3 formato garso bylą 

(MP3 garso formatas daţniausiai naudojimas Internete), kuri yra tame pačiame 
jūsų JQUIZ uţduoties aplankale. Jūs norite, kad mokiniai, prieš atsakydami į 
pirmą klausimą jūsų klausimyne, paklausytų šį garso įrašą. Jūs turite padaryti 
taip: 

 įsitikinti, kad JQUIZ uţduoties byla įrašyta; 
 paspausti klausimo lauke «Question 1»; 

 pasinaudokite «Insert (Įterpimas) meniu komandas Link →Link to 
Local File (Nuoroda → Nuoroda į bylą esančią kompiuteryje); 

 pasirodys bylos atvėrimo langas «Open» (Atidaryti), langelyje «Look in» 
(Kur ieškuoti) pasirinkite laikmeną, pagrindiniame lange raskite ir 
atverskite aplankalą, kuriame laikoma reikalingo garso byla, ir parinkite 
jos rinkmeną, paspauskite mygtuką «Open» (Atidaryti): 

 

 
 
Dabar jus pamatysite dialogo langą «Insert Link» (Įterpti nuorodą): 
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 laukelyje «Link text» (nuorodos tekstas) įrašykite paaiškinimo tekstą 
pvz., „Paspauskite šioje vietoje, kad paklausytumėt tekstą (melodija) ir 
t.t.); 

 paspauskite mygtuką OK. 
 

 
 
Nuoroda atsiranda pirmo klausimo lange, dabar, komplektuojant savo internetinį 
puslapį, jūs tūrite pamatyti nuorodą pirmame klausime.   
   

 
 
Paspauskite nuorodą ir išgirsite pasirinktą garso įrašą. 
 

Atkreipkite dėmesį, kad įrašas paleidžiamass programos pagalba, kurią išrinko vartotojas pvz., 

QuickTime, Windows Media Player ir kitos, jūs tai kontroliuoti negalite. 

 

2.4.5.1. Nuoroda į filmuotą medžiagą 
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Nuorodos įterpimas į filmuotą medţiagą niekuo nesiskiria nuo nuorodos įterpimo į garso 
bylą. Reikia atlikti  ţingsnius, paminėtus aukščiau, tik išrinkti reikia filmuotos medţiagos 
bylą. Atkreipkite dėmesį, kad norint perţiūrėti filmuotą medţiagą, naudotojo kompiuteris 
turi pajėgti apdoroti jūsų nustatytą  formatą. Būtinai įsitikinkite, kad vartotojas turi 
reikiamą programą filmuotai medţiagai perţiūrėti. Jūs galite savo puslapyje pateikti 
nuorodą į internetinį puslapį, iš kurio galima reikiamą programą atsiųsti ir įdiegti.       
 

2.4.5.2. Objektų įterpimas 

 

Norint patalpinti medijos bylas:  
1. pasirinkite «Insert» (Įterpimas) meniu komandą «Media Object » (Medijos 

objektas): 
 

 
 
Atveriamas dialogo langas «Insert a medija object» (Įterpimas medijos objekto), 
kuriame jūs galite: 

 įterpti pasirinktą bylą su mygtuko «Browse » (Paieška) pagalba ir ją 
perklausyti/perţiūrėti (mygtukas  «Play» (Groti);  

 redaguoti dokumento formatą laukeliuose «Widht» (Plotis) ir «Height» (Aukštis);   
 pasirinkti medijos bylos grotuvą/grotuvus pvz., komanda «Add Windows Media 

Player» (Įdėti  Windows medijos grotuvą) ir t.t. Jus tūrite galimybę pasiūlyti 
keletą grotuvų iš karto ir  Internet Explorer parodys visą grotuvų sąrašą, todėl 
geriausia pasiūlyti vieną grotuvą. Galiausiai jūs visai nenurodykite jokio grotuvo, 
nes niekada negali ţinoti, kokį grotuvą turi mokinys savo kompiuteryje;  

 taip pat šiame dialogo lange galite įrašyti nuorodos pavadinimą laukelyje «Link 
text » (Nuorodos tekstas): 
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2. paspauskite mygtuką «OK». 
 

2.5 Užduoties pertvarkymas į internetinį puslapio formatą ir 
užduoties bylos įrašymas 

 
Įvestus duomenis (uţduotys ir konfigūracijos nustatymai), reikia pertvarkyti į 

uţduoties formatą – Internetinį puslapį ir įrašyti.   
 
Tam tikslui meniu «File» (Byla) naudojama komanda «Create Web-page» 

(Internetinio puslapio kūrimas),  
 

 
 
 

arba įrankių juostos atitinkamas mygtukas (*Ten, kur numatyti keletas užduoties formatų, 

šioje meniu komandoje ir įrankių juostoje, atsiranda jų sąrašas). 
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Išrinkus iš sąrašo norimą formatą, arba spragtelėjus mygtuką «Create Web-page» 
(Internetinio puslapio kūrimas), atsiranda dialogo langas «Save as» (Įrašyti kaip), 
kuriame reikia įvesti uţduoties bylos pavadinimą ir sukurti aplankalą, į kurį ji bus  
įrašyta.  

*Bylos pavadinime pageidautina nurodyti temą ir užduoties eilės numerį; nepatartina 

rašyti tarpų, nes tai gali sukelti problemų dirbant su kai kuriomis Interneto naršyklėmis. 

 
 

 

Spragtelėjus mygtuką «Save» (Įrašyti), atsiranda dar vienas dialogo langas – 
«View or upload the exercise» (Perţiūrėti uţduotį, arba patalpinti į Internetinį tinklapį), 
kuriame nurodyti trys tolimesnių veiksmų būdai: 

 

1.  - perţiūrėti sukurtą uţduotį Internetinės naršyklės pagalba (View the 
exercise in my browser); 

2.  - patalpinti uţduotį Internetiniame tinklapyje www.hotpotatoes.net 
(Upload the file to the hopotatoes.net Website); 

3.  -   nieko nedaryti (Nothing).  
 

 

http://www.hotpotatoes.net/


                                                                                                        Hot Potatoes vartotojo vadovas 

_______________________________________________________________________ 

Paruošė Tatjana Radzevičienė 

27 

 
 
 
 
Išrinkus pirmąjį būdą  «View the exercise in my browser» (Perţiūrėti uţduotį  

Internetinės naršyklės pagalba), pasirodys  uţduoties vaizdas, kurį matys atliekantis ją  
mokinys. 

Uţduotį galima ne tik pamatyti, bet ir atlikti. Uţdarius uţduoties perţiūros langą, 
sugrįţtama į darbinį duomenų įvado ekraną.   

 
Jeigu po uţduoties perţiūros reikia įvesti kai kurių pakeitimų, tai galima atlikti po 

perţiūros, o po to būtinai dar karta pertvarkyti užduoties duomenis 
ir įrašyti (pakeisti) sukurtą anksčiau užduoties bylą (šią procedūrą 

kartojame atlikus bet kokį bylos duomenų pakeitimą). 
 
Išrinkus antrąjį būdą (patalpinti uţduotį Internetiniame tinklalapyje 

www.hotpotatoes.net), reikia laikytis Internetinio puslapio www.hotpotatoes.net 
naudojimo sąlygų.    

 
Išrinkus trečiąjį būdą (nieko nedaryti ), byla įrašoma be išankstinės uţduoties 

perţiūros, ir sugrįţtama į darbinį duomenų įvedimo ekraną.  
  

2.6 Pradinės bylos duomenų išsaugojimas 

 
Kadangi paruoštose uţduotyse (Internetiniame puslapyje) pakeitimų atlikti jau 

negalima, visi pakeitimai (tekstinės medţiagos ir konfigūracijos) vykdomi pradinėje 
duomenų byloje. 

 
Tam, kad vėliau galima būtu pakeisti sukurtas uţduotis (redaguoti tekstinę 

medţiagą arba konfigūraciją), reikia įrašyti duomenų bylą.  
 
Tai galima atlikti: 

http://www.hotpotatoes.net/
http://www.hotpotatoes.net/
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 pabaigus duomenų įvedimą ir konfigūracijos nustatymą;  

 perţiūrėjus sukurtą Internetinį puslapį; 
 išeinant iš programos. 

 
Duomenų byla įrašoma standartiniu būdu: naudojant meniu «File» (Byla) komandą 

«Save» (Įrašyti) arba «Save as» (Įrašyti kaip) arba atitinkamus įrankių juostos 
mygtukus.  

 
Kiekvieno programos bloko duomenų byla (kiekvieno uţduoties tipo) turi savo 

prievardį ir piktogramos spalvą.  
 
*Užduoties duomenų bylos, apjungtos į vieną pamoką arba teminį bloką su «Įrankiai» 

bloko pagalba, pažymimos programos «Įrankiai» piktograma. 

 

 

 

 

 

 

 

užduotis 
 

piktograma bylos 
prievardis 

JQuiz Klausimynas 

 

*.jqz 

JCloze 
Praleistų ţodţių įrašy-
mas  

*.jcl 

JCross Kryţiaţodis *.jcw 

JMix 
Ţodţių eiliškumo saki-
nyje nustatymas   

*.jmx 

JMatch 
Atitikmenų porų išdė-
liojimas  

*.jmt 

Masher Įrankiai 

 

*.jms 

 
Norint lengviau orientuotis duomenų bylose ir uţduotyse, rekomenduojama 

duomenų byloms ir uţduočių byloms suteikti vienodus pavadinimus ir įrašyti 
duomenų bylas viename aplankale kartu su sukurtomis užduotimis. 

 

2.7 Užduočių spausdinimas 
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Visas uţduotis galima atspausdinti; spausdinant iš uţduoties duomenų bylų – 
uţduotys spausdinamos su atsakymais. Visas uţduotis  (išskyrus kryţiaţodį) programa 
kopijuoja į iškarpinę, o po to standartiniais būdais įterpia į tekstinį dokumentą ir 
spausdina tekstinio redaktoriaus pagalba.  

 
Kryţiaţodis spausdinamas iš internetinės naršyklės kaip Internetinis puslapis, 

specialiai sukurtas spausdinimui (daugiau apie kryžiažodžių spausdinimą žr. skyriuje  

3.4.). 
 

2.8 Užduočių apjungimas į pamokas ir teminius planus 

 
Sukurtas uţduotis galima apjungti į teminius planus, pamokas ir pamokų serijas 

įvairiais būdais (daugiau žr. skyriuje 5). Programos blokas «The Masher» (Įrankiai) 

suteikia galimybę tai atlikti automatiškai ir apjungti uţduotis ne tik į pamokas, bet ir į 
pamokų serijas, įterpti į pamokas medţiagą, sukurtą kitų programų pagalba, ir apjungti 
medţiagą į mokomuosius kursus. 
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3. Užduočių kūrimo patarimai (tekstinės medžiagos 
pagrindu)  

 

3.1 Klausimynas (JQuiz) 

 

 
 

      Šios programos bloko pagalba gali būti sukurtos uţduotys, grindţiamos klausimais ir 
įvairių atsakymų variantų pateikimu: 

 

 «daugybė pasirinkimų» (multiple choice) – vienas teisingas atsakymas iš 
kelių atsakymų variantų; 
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 Kelių teisingų atsakymų pasirinkimas (multi-select); 
 

 
 

 «trumpas atsakymas» (short answer) – trumpas atsakymas atviro tipo 
(įvedamas klaviatūros pagalba); 
 

 
 

 «mišrus» (hybrid) atsakymo variantas – apjungia klausimus su atviro tipo 
atsakymais ir klausimus su daugybe atsakymų pasirinkimų: įvedus kelis kartus 
neteisingą atsakymą (skaičius galimų neteisingų atsakymų nustatomas kuriant 
uţduotį), uţduotis su trumpu atsakymu transformuojasi į uţduotis su keliais 
atsakymų pasirinkimais. 
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Atsakymo tipas uţduotyje gali būti tas pats visiems klausimams, arba keistis 

kiekvienam klausimui, ar klausimų grupei.  
 
Klausimų skaičius uţduotyje neribojamas. 
 
Atliekant uţduotį su specialiojo mygtuko, esančio viršutiniame dešiniajame ekrano 

kampe pagalba, mokinys gali pasirinkti ar matyti ekrane vieną kausimą («question one 
by one»), ar visus klausimus iškart («Show all the questions»). 

  

3.1.1 Duomenų įvedimas 

 
 Paleisti programą Hot Potatoes, išrinkti ekrane «JQuiz» arba iš meniu «Potatoes» 

(Uţduotis) – atsivers šio programos bloko darbinis langas. 
 

1. Įvesti uţduoties pavadinimą (laukelis «Title»);  
 

2. Įvesti klausimą į laukelį («Q») ir atsakymus (laukelis «Answers»). 
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3. Išrinkti iš esančio kairėje nuo laukelio «Q» (Klausimas) išskleidţiamojo sąrašo 

atsakymo tipą: «multiple choice» (daugybę pasirinkimų) – nustatytas pagal išankstinius 
programos nustatymus; «multi-select» (keletą teisingų atsakymų); «short answer» 
(atviras trumpas atsakymas), «hybrid» (mišrus).  

 

 
 

4. Paţymėti teisingą/gus atsakymą/mus laukelyje «Correct» (Teisingas). 
 

* Į klausimą su trumpu atviru atsakymu gali būti ir vienas, ir keletas teisingų atsakymų variantų. 

 
5. Norint įvesti atsakymų komentarus (visiems arba atskiriems, pavyzdţiui, tiktai 

neteisingiems) laukelyje «Feedback» (Grįţtamasis ryšys): 
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Norint pereiti prie sekančio klausimo, naudojamos rodyklės, esančios šalia 
klausimo numerio laukelio.  

 
Klausimus ekrane galima pamatyti po vieną arba visus iškart. 

 

 Nustatyti tam tikrą klausimų, matomų ekrane, skaičių (vienas klausimas, 
keletas klausimų, arba visi klausimai iškart; jeigu klausimų skaičius nenustatytas, 
tai pasirinkimą – «parodyti vieną arba visus iškart» – padaro mokinys). 
 

3.1.2 Užduoties redagavimas 

 

Uţduoties redagavimas vyksta  su meniu «Manage Questions» (Klausimų apdoro-
jimas) komanda, kurioje yra šis komandų sąrašas: visų klausimų perţiūra (View Quiz 
Outline), šalinimas (Delete Questions), kopijavimas (Clone Question), pertempimas 
(Move Questions), klausimų įterpimas (Insert Question), perskirstymas pačių klausimų ir 
atsakymų (Shuffle):  

 

 
 

6. Įvedus duomenis ir atlikus uţduoties redagavimą, būtinai reikia pertvarkyti 
duomenis uţduotyje (Internetinį puslapį) – ţr. skyrių 2.3 

7. Įrašyti duomenų bylą – ţr. skyrių 2.4. 
 
Po to galima: 
 
а) sukurti naują uţduotį tame pačiame programos bloke: «File» (Byla) – «New» 
(Naujas) arba įrankių juostos atitinkamas mygtukas; 
б) uţdaryti šį programos bloką ir pereiti prie kito bloko, esančio pagrindiniame 
programos Hot Potatoes ekrane;  
в) baigti darbą su programa Hot Potatoes. 

 

3.1.3 Papildomos galimybės – konfigūracijos išvedimas 

 
Klausimynas turi daugelį galimybių konfigūracijos uţduotims išvesti. Pasirinkus  

kortelę «Other» (Kitoks) lange «Configure Output» (Konfigūracijos išvedimas), galima:  
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 keisti klausimų tvarką kiekvieną kartą pradedant uţduotį; 
 rodyti klausimų skaičių, į kuriuos buvo atsakyta teisingai iš pirmo karto; 

 rodyti bendrą įvertinimą po kiekvieno teisingo atsakymo; 
 atsiţvelgti į raidţių  registrą (maţosios, didţiosios) tikrinant atsakymą; 
 rodyti sąrašą kitų galimų teisingų atsakymų; 
 nustatyti trumpo atsakymo, bandymų įvedimo skaičių, po kurio uţduotis 

performuojama į klausimą su keletu atsakymų variantais (nustatymas naudojamas 
klausimuose su mišriu atsakymų tipu); 

 naudoti virtualią klaviatūrą (trumpiems atsakymams); 
 rodyti ekrane nustatytą klausimų kiekį.  

 
Be to, daugiau patirties turintys vartotojai gali pasinaudoti galimybe įvertinti 

atsakymo  teisingumo laipsnį; atsiţvelgti į dalinai teisingus atsakymus; įjungti testavimo 
reţimą.  

 
Norint išnaudoti papildomas programų galimybes, klausimyne reikia nustatyti 

patyrusio vartotojo veikseną «Advanced mode» meniu «Options» (Parinktys) išrinkti 
komanda «Mode» (Veiksena). 

 

 
 

Instrukcijas patyrusiams vartotojams patalpinti atitinkamame skyriuje («For power-
users») programos ţinyne. 
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3.2.  Praleistų žodžių įrašymas (JCloze) 

 

 

3.2.1. Duomenų įvedimas 

 

1. Paleisti programą Hot Potatoes, išrinkti «JCloze» ekrane arba meniu «Potatoes» 
(Bulvės) – atversti šios programos bloko darbinį langą. 

 
2. Įrašyti uţduoties pavadinimą (laukelyje «Title»).  

 
3. Įvesti tekstą, kuriame bus padaryti ţodţių praleidimai arba raidţių praleidimai 

ţodţiuose dideliame lauke po pavadinimo laukelio. Tekstas įvedamas klaviatūros 
pagalba, arba kopijuojamas iš bet kokio dokumento. 

 

 
 

4. Paţymėti ţodţius arba raides, kurie bus praleisti uţduotyje. Tam reikia paţymėti 
reikiamą ţodį arba jo dalis,  ir paspausti mygtuką   «Gap» (Tarpas).  
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Laukelyje «Gapped words alternatives» (Praleistų ţodţių variantai) paţymėtas 
ţodis bus parodytas laukelyje «Word» (Ţodis), laukelyje «Gap#» (tarpo numeris) bus 
nurodytas praleisto ţodţio eilės numeris tekste.  

 

 
 

Jeigu yra nenumatyti pasakinėjimai mokiniams, arba  atsakymų variantai, tai galima 
paspausti mygtuką «ОК» ir tęsti ţymėti praleistus ţodţius tekste. 
 

Ţodţiai (raidės), paţymėti kaip tarpai, automatiškai nusidaţo tekste raudona spalva 
ir pabraukiami:  

 Ţodţių tarpams rinkimo eiliškumas tekste  neturi reikšmės, nes visi praleisti 
ţodţiai numeruojami automatiškai nuo teksto pradţios.  

 

 
 

3.2.2. Užduoties redagavimas 

 
Mygtukai «Delete Gap» (Pašalinti tarpą) ir «Clear Gaps» (Pašalinti visus tarpus) 

suteikia galimybę pakeisti ţodţius, kurie bus praleisti uţduotyje.  
Mygtukas «Show words» (Parodyti praleistus ţodţius) leidţia pereiti į dialogo langą  

«Gapped words alternatives» (Praleistų ţodţių variantai) ir redaguoti pasakinėjimus, 
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arba galimus teisingų atsakymų variantus, išrenkant praleistus  ţodţius pagal eilės 
numerį. 
 

5. Pagal mokytojo pageidavimą praleistus ţodţius galima rodyti ekrane, arba ne: 
 

 
 

 
 
 
Norint parodyti praleistus ţodţius ekrane, reikia konfigūracijos išvedime (Configure 

Output) išrinkti kortelę «Other» (Kitas) ir paţymėti langelį «Include word list with text» 
(Parodyti pralestų ţodţių sąrašą ekrane). Jeigu šio langelio nepaţymėsite, praleisti 
ţodţiai ekrane nepasirodys. 

 



                                                                                                        Hot Potatoes vartotojo vadovas 

_______________________________________________________________________ 

Paruošė Tatjana Radzevičienė 

39 

 

3.2.3. Papildomos galimybės 

3.2.3.1. Pasakinėjimai ir teisingų atsakymų variantai 

 

Dialogo lange «Gapped words alternatives» (Teisingų atsakymų variantai) 
laukelyje «Clue» (Pasakinėjimas) galima įrašyti pasakinėjimą praleistam ţodţiui 
(vertimas, sinonimas, antonimas, aiškinimas), kuriuos galima pamatyti atliekant uţduotį. 
Be to, esant reikalui, laukeliuose «Alternative correct answers» (Teisingų atsakymų 
variantai) – galima įrašyti teisingų atsakymų variantus.  

* Teisingų atsakymų variantus ir pasakinėjimus galima įrašyti ne visiems žodžiams.  

 

 
 

Jeigu į uţduotį buvo patalpinti pasakinėjimai, tai juos galima pamatyti paspaudus 
mygtuką «?» esantį šalia kiekvieno ţodţio, kuriam buvo sukurtas pasakinėjimas. 
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3.2.3.2. Automatinis tarpų kūrimas 

 
Programoje numatytas automatinis tarpų sukūrimo reţimas. Jį galima įjungti pas-

paudus mygtuką «Auto-Gap» (Auto-tarpas). Dialogo lange «Auto-Gap» (Auto-tarpas) 
reikia nurodyti ţodţius, kurie bus praleisti, eilės numerius, pavyzdţiui, kiekvienas antras 
ţodis, kiekvienas penktas ir t.t. lange «Type a number for “n”» (Įveskite ţodţio numerį).  

 

 
 

3.2.3.3. Atsižvelgimas į raidžių registrą (mažosios/didžiosios) tikrinant atsakymus 

 
Konfigūracijos nustatymuose galima nustatyti arba panaikinti atsiţvelgimą į 

maţąsias arba didţiąsias raides, vertinant įvestų atsakymų teisingumą. 
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Norint tai atlikti, reikia lange «Configuration file» (Konfigūracijos byla) pasirinkti 
kortelę «Other» (Kitas) ir paţymėti arba panaikinti ţymėjimą «Make answer-checking 
case sensitive» (Atsiţvelgimas į registrą vertinant atsakymus) langelyje. 

 
 

 
 
 
Be to, šioje uţduotyje galima patalpinti virtualiąją klaviatūrą ekrane; tada mokinys 

galės nespausdinti ţodţių, o įvesti raides kompiuterio pelės pagalba. (Daugiau apie 
virtualiąją klaviatūrą ţr. skyriuje 3.7) 

 
6. Po duomenų įvedimo ir uţduoties redagavimo reikia pertvarkyti uţduoties 

duomenis (interneto puslapį) – ţr. skyrių 2.3 
7.  Išsaugoti duomenų bylą – ţr. skyrių 2.4. 

 
Po to galima: 
 
а) sukurti naują uţduotį tame pačiame programos bloke «File» (Byla) – «New» (Naujas) 
arba atitinkamo įrankio juostos mygtuko pagalba; 
б) uţversti šį programos bloką ir pereiti į kitą bloką pagrindiniame programos Hot 
Potatoes ekrane;  
в) baigti darbą su programa Hot Potatoes. 

 

3.3.  Atitikmenų porų išdėliojimas (JMatch) 
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Atitikmenų poros šio tipo uţduotyse išdėliojamos, kaip taisyklė, tarp šių elementų: 
 

ţodis – sinonimas 
ţodis – antonimas 
frazė – aiškinimas 
ţodis – apibrėţimas 
ţodis – vertimas 
ţodis – atvaizdas 
ţodis – garsinė forma ir t.t. 

 
 Šiose uţduotyse yra uţduotys, kuriose reikia atkurti elementų nuoseklumą, t.y. 

nuosekliai išdėstyti eilės numerius ir atitinkančius jiems ţodţius, ar sakinius.  
 

(1) First:  Start a Hot Potato. 
(2) Second:  Enter your data. 
(3) Third:  Save your data. 
(4) Fourth:  Set the correct configuration. 
(5) Fifth:  Click on "File / Create Web page". 

 
 
Uţduotis gali būti  pateikta trijuose formatuose: 

 atitikmenų porų išdėliojimas perkeliant elementus pelės pagalba; 

 atitikmenų porų pasirinkimas iš išskleidţiamojo sąrašo; 

 atitikmenų porų atminties kortelės. 

 
Uţduoties tipas pasirenkamas pertvarkant duomenis į uţduotį. 

3.3.1. Duomenų įvedimas 

 
1. Paleisti programą Hot Potatoes, pasirinkti ekrane «JMatch» bloko piktogramą, 

arba iš meniu «Potatoes» (Bulvės) – atsivers šios programos bloko darbinis langas. 
 
2. Įvesti uţduoties medţiagą į atitinkamus laukus: pirmas laukas skirtas fiksuotam 

elementų sąrašui, kuris bus patalpintas ekrano kairėje pusėje; antras laukas skirtas 
elementams, iš kurių bus vykdomas elementų atitikčių parinkimas fiksuotam elementų 
sąrašui.  

Elementai įvedami nuosekliai  – jie susimaišo automatiškai, paleidţiant uţduotį. 
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Pirmiems dviems uţduočių tipams įvedant duomenis, galima panaudoti galimybę 
fiksuoti vieną elementą iš perkeliamo sąrašo elementų, paţymėjus «Fix» (fiksuoti) 
langelį šalia  vienos iš atitikties. Atitikmenų pora,paţymėta kaip «fiksuota», pasirodys 
ekrane automatiškai ir bus kaip teisingo atsakymo ir uţduoties atlikimo pavyzdys. 
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Antro tipo uţduotyse  (atitikmenų porų elemento išrinkimas iš sąrašo) naudojamas 

laukas «Default» (Numatytasis).  
 

 
 
Tekstas, įvestas į šį lauką, pasirodo ekrane kaip pirmas išskleidţiamo sąrašo ţodis. 

Tai gali būti:  
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 vienas, arba keletas klaustukų (taip numatyta pagal išankstinius 
programos nustatymus): 

 

 
 

 tuščias laukas – toks jis lieka uţduoties ekrane: 
 

 
 

 papildomas neteisingas atsakymas: 
 

 
 

 vienas iš teisingų atsakymų  
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Atsakymas įrašomas tiktai į lauką «Default» (Numatytasis) ir neįrašomas į 

atitikmenų porų lauką: 
 

 
 

3.3.2. Užduoties redagavimas 

 

Užduoties redagavimas vyksta meniu «Manage Items» (Elementų tvarkymas) 
komandos pagalba: galima keisti elementų nuoseklumą fiksuotame sąraše (View 
Exercise Outline), įterpti (Insert item), perkelti (Move Item) ir šalinti (Delete Item) 
įvestus atitikimus, keisti įrašytų elementų nuoseklumą ir atitinkamus jiems teisingus 
atsakymus (Shuffle items) ir keisti vietomis laukus (Shuffle left items with right items). 
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3. Pakeisti duomenis į uţduoties internetinio puslapio formatą. Norint tai atlikti, 

reikia pasirinkti uţduoties formatą:  
 
3.1. Uţduočių, kuriose nustatomos atitikmenų poros perkeliant elementus kom-

piuterio pelės pagalba, kūrimui reikia meniu Byla komandoje «Create Web-page» 
(Kūrimas Internetinio puslapio) išrinkti punktą «Drag/Drop Web-Page» («Internetinis 
puslapis su perkėlimu) arba atitinkamą įrankio juostos mygtuką. 

 
3.2. Norint sukurti uţduotį, kuriame iš išskleidţiamo sąrašo išrenkamas atitikmenų 

porų variantas, reikia meniu Byla komandoje «Create Web-page» (Kūrimas Internetinio 
puslapio) pasirinkti punktą  «Web-Page» (Internetinis puslapis), arba atitinkamą įrankio 
juostos mygtuką.  

 
3.3. Ţodţių ir išsireiškimų atminties kortelės sukūrimas vyksta tiktai  meniu 

pagalba: «File» (Byla) – «Create Web-page» (Kūrimas Internetinio puslapio) – 
«Flashcards» (Kortelės).  

 

 
Atliekant užduotį, ekrane iš pradţių pasirodo kortelė, kurioje parašytas vieno iš 

uţduoties lauko tekstas, po mygtuko «Next» (Tęsti) paspaudimo, atsiranda dvi teisingo 
atitikties varianto kortelės.  
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Mygtuko «Next» (Tęsti) pagalba atliekamas perėjimas prie sekančių atitikmenų 

porų. Korteles su išmoktomis atitikmenimis galima panaikinti sąraše mygtuko «Delete» 
(Šalinti) pagalba.  

 
4. Po duomenų įvedimo  ir uţduoties redagavimo reikia pertvarkyti duomenis į 

uţduotį (Internetinį puslapį) – ţr. skyrių 2.3 
5. Įrašyti duomenų bylą – ţr. skyrius 2.4. 

 
Po to galima: 
 
а) sukurti naują uţduotį tame pačiame programos bloke «File» (Byla) – «New» (Naujas) 
arba su atitinkamu įrankių juostos  mygtuku; 
б) uţversti šį programos bloką ir pereiti prie kito bloko pagrindiniame programos Hot 
Potatoes ekrane;  
в) baigti darbą su programa Hot Potatoes. 
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3.4. Kryžiažodis (JCross) 

 

 
 

3.4.1. Duomenų įvedimas 

 
1. Paleisti programą Hot Potatoes, surinkti «JCross» ekrane arba iš meniu 

«Potatoes» (Bulvės) – atsidarys šios programos bloko darbinis langas. 
 
2. Įrašyti kryţiaţodţio pavadinimą į lauką «Titile» (Pavadinimas). Planuojant 

spausdinti išspręstą kryţiaţodį, šį lauką būtina uţpildyti. 
 
3. Patalpinti ţodţius kryţiaţodyje (sukurti kryţiaţodţio tinklelį). Įmanomi du ţodţių 

patalpinimo būdai  – rankinis ir automatinis. 
 

 
 
Patalpinant ţodţius rankiniu būdu, ţodţių padėtį tinklelyje nustato pats vartotojas: 

ţodţiai įvedami į kryţiaţodţio lauką po vieną raidę.  
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Patalpinant ţodţius automatiškai, visi ţodţiai įvedami sąrašu į ţodţių įrašymo lauką 
lange «Create a crossword grid automatically» (Automatinis tinklelio kūrimas), o po to 
programa parenka jų patalpinimo variantus. 

 
Automatiniam kryţiaţodţių tinklelių sukūrimui reikalinga: 
 

 išrinkti iš meniu «Manage Grid» (Tinklelio tvarkymas) komandą «Automatic 
Grid-Maker» (Automatinis tinklelio kūrimas) arba atitinkamą įrankių juostos 
mygtuką; 

 įrašyti maksimalų skaičių langelių kryţiaţodyje į atitinkamą lauką 
«Maximum grid size»; 

 įrašymo ţodţių lauke įrašyti visus kryţiaţodţio ţodţius – kiekvienas žodis 
įrašomas naujoje eilutėje; 
 

 
 

 paspausti mygtuką «Make the grid» (Sukurti tinklelį) 
 

Įrašyti ţodţiai bus patalpinti į kryţiaţodţio lauką: 
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*Mygtukų-rodyklių, esančių kairiajame apatiniame ekrano kampe pagalba, galima 

kilnoti kryžiažodį lauko ribose. 
 

4. Įrašyti ţodţių apibrėţimus. Apibrėţimais gali būti klasikinės definicijos, 
sinonimai, antonimai, taip pat sakiniai ir posakiai, leidţiantys tiksliai suprasti 
kryţiaţodţio ţodţių reikšmę. 

 
Paspaudus mygtuką «Add Clues» (Įdėti apibrėţimus), pasirodo apibrėţimų redaga-

vimo langas. Viršutinėje ekrano dalyje patalpinti ţodţiai, kurie kryţiaţodyje parašyti ho-
rizontaliai (Across), apatinėje – vertikaliai (Down). Norint įrašyti apibrėţimą, reikia 
paryškinti pasirinktą sąrašo ţodį, lauke po sąrašu įrašomas apibrėţimas ir 
paspaudţiamas mygtukas «OK».  

 
Apibrėţimų įvedimo nuoseklumas nеturi reikšmės. 
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Įrašius apibrėţimus, galima atlikti bet kokį tinklelio pakeitimą kilnojant  ţodţius; 

programa išsaugos atitinkamus apibrėţimus. 
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3.4.2. Papildomi nustatymai 

 
Apibrėţimų pateikimas uţduotyje. Uţduoties-kryţiaţodţio ekrane apibrėţimai gali 

būti pateikti po vieną, arba visi kartu. Programoje numatytas vieno apibrėţimo 
pateikimas išrinktam ţodţiui. Norint, kad ekrane pasirodytų visi apibrėţimai, reikia 
paţymėti laukelį  «Show all clues below the crossword grid» (Parodyti visus kryţiaţodţio 
apibrėţimus) lange kortelės «Other» (Kitas) nustatymo konfigūracijoje (Options – 
Configure output).  

 

 
 

 
5. Po duomenų įvedimo ir uţduoties redagavimo, reikia pertvarkyti duomenis į 

uţduotį (Internetinį puslapį) – ţr. skyrių 2.3 
6. Įrašyti duomenų bylą – ţr. skyrių 2.4. 

 
Po to galima: 
 
а) sukurti naują uţduotį šiame programos bloke atliekant šiuos veiksmus: «File» (Byla) 
– «New» (Naujas), arba atitinkamo mygtuko pagalba įrankių juostoje; 
b) uţversti šį programos bloką ir pereiti prie kito bloko pagrindiniame programos ekrane 
Hot Potatoes;  
c) pabaigti darbą su programa Hot Potatoes. 
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3.4.3. Užduoties atlikimas 

 
Uţduotis galima atlikti nebūtinai eiliškumo tvarka; išrinkus ţodţio numerį, atsiranda 

jo apibrėţimas (nepriklausant nuo to, ar jau yra visų apibrėţimų sąrašas ekrane). 
 

 
 
 
 

3.4.4.  Kryžiažodžio spausdinimas 

 
Spausdinimo versija sukuriama Internetinio puslapio pavidalu, kuris gali būti dviejų 

variantų – su tuščiu ir išspręstu kryţiaţodţiu. 
 
Norint sukurti Internetinį puslapį su kryţiaţodţiu, spausdinimui reikia iš meniu 

«File» (Byla) išrinkti komandą «Export for printing» (Eksportas spausdinimui). 
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Ekrane pasirodo Internetinis puslapis su kryţiaţodţiu juodame-baltame variante: 
 

 
 
Norint atspausdinti puslapio variantą su  išspręstu kryžiažodžiu, reikia nukreipti 

rodyklę į paruošto puslapio kryžiažodžio pavadinimą ir spragtelti kairiu pelės 
klavišu. Pakartotinas pavadinimo spragtelėjimas sugrąţina prie pradinio puslapio 
variantų – puslapis su neišspręstu kryţiaţodţiu. 
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Sukurti Internetiniai puslapiai spausdinami standartiniais būdais kaip iš ţiniatinklio 

naršyklės, taip ir iš teksto redaktoriaus. 
 
Taisyklingam kryţiaţodţio spausdinimui iš ţiniatinklio naršyklės reikalingas 

išankstinis naršyklės nustatymas (spausdinti «Fono spalvos ir vaizdai»).  
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3.5. Žodžių eiliškumo sakinyje nustatymas (JMix) 

 

 
 
Uţduoties medţiaga gali būti ţodţiai ir sakiniai. Kiekvienam ţodţiui ar sakiniui 

sukuriama atskira užduotis. 

3.5.1. Duomenų įvedimas 

1. Paleisti programą Hot Potatoes, surinkti «JMix» ekrane arba meniu «Potatoes» 
(Bulvės) – atsidarys darbinis šios programos bloko langas. 

 
2. Lauke «Title» įrašyti uţduoties pavadinimą. 
 
3. Įrašyti lauke «Main Sentence» (Pagrindinis sakinys) ţodį, posakį, arba sakinį. 

Kiekvienas segmentas (raidė, ţodis, posakis, skyrybos ţenklas) įrašomas iš naujos 
eilutės: 
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Uţduotyje reikia naudoti standartines dvigubas kabutes, arba visiškai atsisakyti  jų; 
taip pat geriau nenaudoti kampinių kabučių (< >), nes jos naudojamos HTML koduotėje 
ir uţduotyje gali būti  panaudotos tiktai norint paţymėti nuorodą į grafines bylas. 

3.5.2. Papildomi nustatymai 

 
Laukas «Alternate sentences» (Atsakymų variantai) uţpildomas sakiniais, kuriuose 

įmanomi ţodţių išsidėstymo skirtingi variantai. Jiems darbiniame lange nustatomos pa-
pildomos parinktys (Options for alternate sentences): 

 

 leisti naudoti sakinius, kuriuose nenaudojami pradinio sakinio visi ţodţiai ir 
skyrybos ţenklai  («Allow sentences which do not use all words and punctuation in 
main sentence»);  

 perspėti, jeigu atsakymo variante nenaudojami pradinio sakinio visi ţodţiai 
ir skyrybos ţenklai  («Warn if alternate sentence does not use all words and 
punctuation in main sentence»).  
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Norint, kad sakinio pirmas ţodis, įrašytas didţiąja raide, nepasakinėtų atliekant 
uţduotį, reikia atlikti šiuos veiksmus: 

 
1) dialogo lange «Configuration file» (Konfigūracijos byla) išrinkti kortelę 

«Prompts/Feedback» (Grįţtamasis ryšys) ir paţymėti «Always capitalize the first letter» 
(Visą laiką išrinkto ţodţio pirmąją raidę rašyti maţąja raide). 

 

 
 

2) perkeliant uţduotį į internetinę naršyklę – atsisakyti rašyti pirmąjį ţodį maţąja 
raide nepriklausomai nuo ţodţio vietos sakinyje – pasirinkti atsakymą «No» (Ne) 
dialogo lange: «Should the word «…» always begin with capital letter, even when it 
isn’t at the beginning of a sentence? » (Ar visa laiką reikia rašyti «…» (pirmąją ţodį 
sakinio) iš didţiosios raides, net jeigu jis nerašomas sakinio pradţioje?) 

 
*Atsakymas «Yes» (Taip) pasirinkamas tuo atveju, jeigu sakinio pirmas žodis  – tikrinis daikta-

vardis. 
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4. Duomenų pertvarkymas į uţduotį (internetinį puslapį). Uţduotys gali būti 
pateiktos dviejuose formatuose:  
 

 elementų pasirinkimas kairės pelės mygtuko spragtelėjimu (Create 
Web page – Web page)  
 

 elementų tempimas su pelės pagalba (Create web-page – Drag/drop 
Web-page): 
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Norint sukurti uţduotį, kurioje elementų nuoseklumas atkuriamas pelės 
spragtelėjimu, reikia meniu File (Byla) pasirinkti komandą «Create Web-page» 
(Internetinio puslapio kūrimas) ir paţymėti punktą «Web-Page» (Internetinis puslapis) 
arba atitinkamą mygtuką įrankių juostoje.  

 
Norint sukurti uţduotį, kurioje elementų nuoseklumas atkuriamas tempiant 

elementus su pele, reikia meniu File (Byla) pasirinkti komandą «Create Web-page» 
(Internetinio puslapio kūrimas) ir paţymėti punktą «Drag/Drop Web-Page» (Internetinis 
puslapis su tempimu) arba  atitinkamą mygtuką įrankių juostoje.  

 
5. Įrašyti duomenų bylą – ţr. skyrių 2.4. 

 
Po to galima: 
 
а) Sukurti naują uţduotį tame pačiame programos bloke atliekant šiuos veiksmus: 
«File» (Byla) – «New» (Naujas) arba atitinkamo mygtuko pagalba įrankių juostoje; 
б) išeiti iš šios programos bloko ir pereiti prie kito bloko pagrindiniame programos Hot 
Potatoes ekrane;  
в) baigti darbą su programa Hot Potatoes. 

 

3.6. Teksto įrašymas į užduotį 

 
Į kiekvieną uţduotį galima įrašyti tekstą, kurio pagrindu bus ruošiama uţduotis. 

Ekrane tekstas bus patalpintas šalia uţduoties. * Tekstas neįrašomas užduotyse JMix 

(Nuoseklumo atkūrimas) ir JMatch (Atitikčių nustatymai), jeigu pasirinktas užduoties atlikimo 

variantas  «elementų tempimas su peles pagalba».  

 

 
 

Norint įterpti tekstą į uţduotį, reikia pasirinkti komandą «Add reading text» (Įterpti 
tekstą) meniu «File» (Byla) arba atitinkamą mygtuką įrankių juostoje.  
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Norint, kad tekstas pasirodytų užduoties ekrane, lange «Add reading text» 
(Įterpti tekstą), būtinai reika paţymėti «Include a reading text» (Įterpti tekstą į 
uţduotį)  

 

 
 
Tekstą galima įterpti su klaviatūros pagalba arba nukopijuoti iš bet kurios bylos :  

 

 
 
 
Tekstą taip pat galima patalpinti ir iš HTML bylos, kurią pasirinkti galima su 

mygtuko «Browse» (Parinkti), esančio po uţrašo «Import text from an external HTML 
file:» (Importuoti tekstą iš išorinės HTML bylos:) pagalba. 

 
*Teksto pavadinimas tokiu atveju įrašomas į atitinkamą lauką automatiškai. 
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3.7. Virtuali klaviatūra 

 
Kalboms, nenaudojančioms lotynų abėcėlės, programa suteikia galimybę panaudoti 

virtualiąją klaviatūrą raidėms įvesti su pelės pagalba.  
Virtuali klaviatūra gali turėti  keletą raidţių arba visas tos kalbos abėcėlės raides. 
 
Norint įjungti virtualiąją klaviatūrą, reikia dialogo lange «Configure output» 

(Konfigūracijos nustatymai) išrinkti kortelę «Other» (Kitas), paţymėti «Include a keypad 
…» (Naudoti virtualiąją klaviatūrą...) ir įrašyti į lauką «Always include these characters 
on the keypad» (Įterpti šių raidţių į virtualiąją klaviatūrą) reikiamas raides. 
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4.  Duomenų bylų ir užduočių išdėstymas   

 
 
Sukuriant uţduotis, domenų bylas patogiau laikyti viename aplankale. 

 
Jeigu uţduočių bylos ne talpinamos į tinklalapį Hotpotatoes.net, mokinių darbui 

uţduočių bylas galima nukopijuoti į kitą aplankalą, prieinamą mokiniams arba patalpinti į 
nuosavą tinklapį (tam reikia kreiptis pas jūsų tinklo administratorių). 

 
*Patalpinimas tinklalapyje Hotpotatoes.net įmanomas iškart po kiekvienos užduoties 

sukūrimo – po duomenų pertvarkymo į internetinį puslapį (žr.skyrių 2.3) arba po užduočių 

sujungimų į pamoką/pamokas su programos «The Masher» (Įrankiai) pagalba – pagrindinė 

meniu «Hotpotatoes.net». 

 

5.  Užduočių sujungimas į pamokas arba teminius blokus    

 
 
Po uţduočių bylų įrašymo į specialųjį aplankalą, kiekvienos uţduoties byla atsidaro 

atskirai: pasinaudojus internetinės naršyklės ir/arba uţduoties mygtukais «Back» (Atgal) 
ir uţdarius puslapį su uţduotimis, įvyks sugrįţimas į uţduočių aplankalą. 

 
Norint nustatyti perėjimą nuo uţduoties iki uţduoties neišeinant iš internetinės 

naršyklės, galima pasinaudoti šiomis galimybėmis: 
 

 nepriklausomai nuo programos Hot Potatoes (pav., teksto redaktoriuje 
Word) sukurti internetinį puslapį «Turinys» su uţduočių sąrašu ir apipavidalinti 
perėjimą nuo uţduoties iki uţduoties su hipernuorodomis;  
 

 Nustatyti perėjimą prie sekančios uţduoties su naršymo nustatymų 
pagalba pradinėse duomenų bylose. Esant tokiam nustatymui, paspaudus 
mygtukus «Next» (Tęsti) arba «Back» (Atgal), įvyksta perėjmas prie reikiamos 
uţduoties. 
 
Be to, su programos bloko «The Masher» (įrankiai) pagalba galima automatiškai 

sukurti: 
 Uţduotis duomenų bylų pagrindu  ir puslapį «Index» (Turinys)» su 

uţduočių sąrašu; 
 

  puslapį «Index» (Turinys) jau sukurtoms uţduotims. 
 

*laisvai platinamoje programos versijos bloke gali būti pamoka su ne daugiau nei 3 užduotimis.  
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5.1.  Internetinio puslapio «Turinys»  kūrimas  su teksto redaktoriumi 
MS Word  

 
Teksto redaktoriaus Word panaudojimas, kuriant internetinį puslapį «Turinys», 

labai palengvina  bet kokių mokomųjų medţiagų, tame tarpe ir uţduočių, sukurtų su 
programa Hot Potatoes, paruošimą. Toks puslapis lengvai papildomas nuorodomis į 
naujas bylas ir uţduotis; uţduočių atlikimo tvarka gali būti nuosekli arba laisvai 
pasirenkama.  

 
Darbo seka: 
 
1. Sukurti keletos uţduočių duomenų bylas.  
 
Nustatant uţduočių naršymą (Navigation), lange «Configuration file» 
(Konfigūracijos byla) kortelėje «Buttons» ( Mygtukai) nеžymėti  šių nustatymų:  
naršymas ir  mygtukų pavadinimai (Captions): 
 

  «Include “Next Exercise” button» (Panaudoti pavadinimą «Next» (Tęsti) 
arba rodykle-simbolį,  rodančią pirmyn, perėjimo prie sekančios uţduoties 
mygtukui paţymėti); 

 «Include “Go to Contents” button» (Panaudoti perėjimo prie puslapio 
«Turinys» mygtuką – ţymėjimą «Index»); 

 «Include “Back” button» (Panaudoti mygtuką «Ankstesnė uţduotis» – 
ţymėjimas «Back» (Atgal) arba rodyklė, rodanti atgal). 
 

 
 
 
2. Įšsaugoti duomenų ir uţduočių bylas. 
 
3. Nukopijuoti visas uţduotis į vieną aplankalą.  
 
4. Tame pačiame aplankale sukurti naują bylą – dokumentą MS Word ir 

išsaugoti ją kaip internetinį puslapį (bylą galima pavadinti «Turinys» arba pagal 
temą arba pamokos numerį). 

 
5. Parašyti byloje uţduočių sąrašą.  
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6. Įterpti bylų su uţduotimis nuorodas. (Norint sukurti nuorodą, reikia paţymėti 
uţduoties pavadinimą  ir paspausti mygtuką «Įterpti hipersaitą» standartinėje 
parankinėje arba išrinkti iš meniu «Įterpimas» komandą « Hipersaitas»).  

 
7. Įrašyti bylą ir išeiti iš redaktoriaus. 
 

5.1.1. Užduočių atlikimas 

 
1. Atidaryti aplankalą, kuriame buvo įrašytos pamokos uţduotys ir puslapis su 

pamokos turiniu.  
 
2. Atidaryti bylą su pamokos turiniu. 
  
Bet kokią uţduotį galima atidaryti pasinaudojant nuorodą (dvigubas spragtelėjimas 

ant pavadinimo kairiuoju pelės klavišu). Perėjimai nuo uţduoties iki uţduoties – su 
internetinio puslapio mygtukais «Atgal» ir «Pirmyn».  

 

5.2. Perėjimas prie kitos užduoties su naršymo nustatymo pagalba 

 
Naudojant naršymo nustatymus, norint sujungti uţduotis į pamoką, puslapis  

«Turinys » nekuriamas; perėjimas nuo uţduoties iki uţduoties gali būti tiktai nuoseklus.  
 
Darbo seka: 
 
1. Įrašyti kelių uţduočių duomenis (kad būtų patogiau jų pavadinimuose, galima 

naudoti numeraciją). 
2. Konfigūracijos išvedimo bylos lange  «Configuration File» – meniu «Options» 

(Parinktys) – «Configure Output» (Konfigūracijos išvedimas) – kortelėje «Buttons» 
nustatyti naršymo mygtukų naudojimą. Naršymo nustatymai pirmai, paskutinei ir visoms 
kitoms uţduotims bus skirtingi. 

 
Naršymo nustatymai pirmoje uţduotyje. 
 
Konfigūracijos išvedime atidaryti kortelę «Buttons» (Mygtukai). Bloke «Navigation» 

(Naršymas): 
 

 pažymėti  mygtuko langelį  «Include “Next Exercise” button» ( Panaudoti 
mygtuką  “Tęsti uţduotį” ); 

 įrašyti sekančios uţduoties bylos pavadinimą į lauką «Next exercise 
URL» (Sekančios uţduoties URL adresas) – įrašyti arba įterpti jį su mygtuko 
«Browse» (Naršyti) pagalba (po jo paspaudimo dialogo lange «Open file» 
(Atidaryti bylą), paţymėti reikiamą bylą ir paspausti mygtuką «Open» (Atidaryti) – 
bylos pavadinimas atsiranda laukelyje); 

 pašalinti ţymėjimą laukelyje «Include “Go to Contents” button» 
(Panaudoti mygtuką “Pereiti  į turinio puslapį”); 

 pašalinti ţymėjimą laukelyje «Include “Back” button» (Panaudoti 
mygtuką “Atgal”). 
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Pirmos uţduoties naršymo skydelyje bus tiktai mygtukas «Tęsti»: 

 

 
 
Naršymo nustatymas  antroje ir kitose uţduotyse. 
 
Konfigūracijos išvedime atidaryti kortelę «Buttons» (Mygtukai). Bloke «Navigation» 

(Naršymai): 
 

 pažymėti laukelį  «Include “Next Exercise” button» (Panaudoti mygtuką 
“Tęsti uţduotį”); 

 įrašyti sekančios uţduoties bylos pavadinimą į lauką «Next exercise 
URL» (Sekančios uţduoties URL adresas) – įrašyti arba įterpti jį su mygtuko 
«Browse» (Naršyti) pagalba (po jo paspaudimo dialogo lange «Open file» 
(Atidaryti bylą), paţymėti reikiamą bylą ir paspausti mygtuką «Open» (Atidaryti) – 
bylos pavadinimas atsiranda laukelyje); 

 pašalinti ţymėjimą laukelyje «Include “Go to Contents” button» 
(Panaudoti mygtuką “Pereiti  į turinio puslapį”); 

 pažymėti laukelį «Include “Back” button» (Panaudoti mygtuką “Atgal”). 
 

Panašūs nustatymai padaromi ir kitoms uţduotims, išskyrus paskutines.  
 

 
 
Antros ir sekančių uţduočių naršymo skydelyje bus mygtukai  «Tęsti» ir «Atgal» 
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Naršymo nustatymas paskutiniojoje  uţduotyje. 
Konfigūracijos išvedime atidaryti kortelę «Buttons» (Mygtukai). Bloke «Navigation» 

(Naršymai): 

 pašalinti ţymėjimą laukelyje  «Include “Next Exercise” button» 
(Panaudoti mygtuką “Tęsti uţduotį”); 

 pašalinti ţymėjimą laukelyje «Include “Go to Contents” button» 
(Panaudoti mygtuką “Pereiti  į turinio puslapį”); 

 pažymėti laukelį «Include “Back” button» (Panaudoti mygtuką “Atgal”). 
 

 
 
Paskutinės uţduoties naršymo skydelyje bus tiktai mygtukas  «Atgal» 
 

 
 
3. Įrašyti duomenų  ir uţduočių bylas. 
 

5.2.1. Užduočių atlikimas   

 
1. Nukopijuoti uţduotis į atskirą aplankalą. 
 
2. Atidaryti pirmos užduoties bylą, norint pereiti nuo uţduoties iki uţduoties, 

panaudojami uţduočių naršymo skydelio mygtukai «Tęsti» ir «Atgal» ir/arba 
internetinės naršylės naršymo mygtukai . 
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5.3. Užduočių automatinis apjungimas į pamoką su programos bloko 
«The Masher» (Įrankiai) pagalba 

 

 
 

Pasinaudojant programos «Įrankiai»  bloko pagalba, uţduotys apjungiamos į 
pamokos aplankalą automatiškai: 

 sukuriamas pamokos internetinis puslapis «Turinys» su nuorodomis į 
uţduotis;  

 visos pamokos uţduotis ir byla «Turinys» patalpinami į vieną aplankalą. 
 
Norint apjungti uţduotis į pamoką su programos bloko «Įrankiai» pagalba reikia: 
 
1. Sukurti ir įrašyti tiktai duomenų bylas.  
 
2. Atidaryti programą «Masher» (Įrankiai). 
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3. Išrinkti kortelę «Index» (Turinys) ir įrašyti pamokos pavadinimą. 
 

 
 
4. Kortelėje «Files» (Bylos) su mygtuko «Add files» (Pridėti bylas) pagalba po 

vieną įrašyti pradinių duomenų bylas, kurios bus apjungtos į pamoką. 
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5. Norint, kad visų pamokos bylų išvaizda būtų vieno stiliaus, reikia išrinkti kortelę  

«Appearance» (Išvaizda) (panašią į kortelę «Appearance» (Išvaizda) uţduočių 
blokuose), įrašyti reikiamus nustatymus ir paţymėti pasirinkimo akutę «Use settings 
specified below for all files» (Panaudoti įrašytus nustatymus visose bylose).  
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Paţymėjus pasirinkimo akutę "Use settings in configuration or data files» 
(Panaudoti įrašytus nustatymus visose bylose), uţduočių išvaizda bus vienoda visose 
duomenų arba konfigūracijos bylose.  

 

 
 

6. Pasirinkti kortelę «Buttons» (Mygtukai) ir nurodyti, ar bus naudojami uţduoties 
darbo lange mygtukai «Next» (Tęsti), «Index» (Turinys), «Back» (Atgal). 

*Net jei buvo padaryti nustatymai kiekvienoje atskiroje užduotyje, užduotims 

sujungtoms į vieną pamoką, galios tiktai nustaymai, padaryti šiame programos 

bloke.  
 

 
 



                                                                                                        Hot Potatoes vartotojo vadovas 

_______________________________________________________________________ 

Paruošė Tatjana Radzevičienė 

73 

7. Įrašyti į aplankalo laukelį  «Output Folder» (Išvesties byla) vietą, kurioje bus 
patalpinta pamokos byla; arba panaudoti mygtuką «Browse» (Naršyti).  

* Tokį aplankalą reikia sukurti anksčiau; jeigu nenurodytas užduočių 

aplankalo pavadinimas, tai užduotis ir turinys bus patalpinti tame  pačiame 

aplankale, kaip ir duomenų bylos. 
 

 
 
8. Norint apjungti uţduotis ir puslapį «Index» (Turinys) į pamoką, reikia paspausti 

mygtuką «Build unit» (Sukurti bloką) apatinėje dialogo lango dalyje arba atitinkamą 
mygtuką įrankių juostoje, arba meniu «Actions» (Veiksmai) komandą «Build unit» 
(Sukurti bloką ).  
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Kai pamoka bus suformuota, pasirodys dialogo langas «Information» 
(informacija):«Would you like to view the unit now?» (Ar jūs norite perţiūrėti bloką?) – 
«Yes» (Taip), «No» (Ne). 

 

 
 
 
Paspaudus mygtuką «Yes» (Taip), ekrane pasirodys sukurtos pamokos turinio  

puslapis su hipernuorodomis į esančias pamokoje uţduotis: 
 
9. Įrašyti pamokos bylą (pagal programos išankstinius nustatymus jai suteikiamas 

pavadinimas „project“, bet galima pasirinkti ir kitokį pavadinimą, pavyzdţiui, „Pamoka“ 
ir t.t.). Pamokos bylą patogiau saugoti tame pačiame aplankale, kuriame yra pamokos 
uţduoties duomenų bylos. 
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5.3.1. Užduočių atlikimas  

 
1. Atidaryti aplankalą, kuris buvo nurodytas kaip pamokos išsaugojimo vieta; jame 

bus patalpintos užduoties ir turinio bylos (Index): 
 

 
 
2. Atidaryti bylą «Index» (Turinys) ir pradėti darbą. 
 
Uţduotys gali būti atliekamos nuosekliai arba laisvai pasirenkant. Perėjimas nuo 

uţduoties iki uţduoties priklausomai nuo padarytų nustatymų  bus atliekamas arba su 
internetinio puslapio mygtukų pagalba, arba su uţduoties perėjimo mygtukais, arba su 
puslapio «Turinys» nuorodų  pagalba.  
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Naršymo skydelyje kiekvienoje uţduotyje bus patalpintas mygtukas «Turinys»: 
 

 
 

5.4. Puslapio «Turinys» automatinis kūrimas su programos bloko 
«The Masher» (Įrankiai) pagalba 

 
Jeigu sukurtos ne tik duomenų bylos, bet ir uţduotys, tai su programos bloku «The 

Masher» (Įrankiai) galima automatiškai sukurti jiems  puslapį «Turinys».  
 
Darbo seka: 
 
1. Sukurti uţduotis. 
 
2. Pernešti uţduotis į atskirą aplankalą. 
 
3. Paleisti programos bloką «The Macher» (Įrankiai). 
 
4. Įterpti pamokos duomenų bylų sąrašą (ţr. skyrius 5.4. punktas 4). 
 
5. Įrašyti į laukelį  «Output Folder» aplankalo,  kuriame bus patalpintas puslapis 

«Turinys»  pavadinimą – įrašyti arba panaudoti mygtuką «Browse» (Naršyklė). Įrašyti 
patalpinimui sukurto aplankalo pavadinimą. Tai turi būti tas pats aplankalas, kuriame 
įrašytos uţduotys. 

 
6. Norint sukurti turinio puslapį, galima panaudoti arba meniu «Actions» 

(Veiksmai) – «Build index page only» (Sukurti tik turinio puslapį), arba atitinkamą 
įrankių juostos mygtuką. 

 
Po to, kai puslapis «Turinys» bus sukurtas, galima bus perţiūrėti pamoką. 
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7. Įrašyti pamokos bylą (ją irgi geriau įrašyti į aplankalą, kuriame yra patalpintos 
pamokos duomenų bylos).  
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6. Papildoma informacija    

6.1. Skyrius «Help» (Žinynas) 

 
Papildomos informacijos skyriuje «Ţinynas» įrašyta: 
 
 programos diegimo ypatumai (Installing and uninstalling – What is installed 

with a program?); 

 įterpimo į uţduotis objektų, garso, grafikos, video, hipernuorodų, instrukcijos  

(General Introduction and help); 

 naujos (palyginus su ankstesniąja versija) versijos 6.0 (General Introduction 

and help) galimybes; 

 papildomos galimybės, kurias gali realizuoti kvalifikuoti vartotojai (For Power-

users); 

 internetinio tinklalapio hotpoptatoes.net paslaugos (General Introduction and 

help – The hotpotatoes.net hosting service)$  

 daţnai uţduodami klausimai (Frequently asked questions); 

 duomenys apie programos autorius ir visus, kurie prisidėjo prie darbo su 

įvairiomis programos versijomis, pvz., sąsajos vertėjus ir t.t. (About the authors, 

Acknowledgements ); 

 papildoma informacija programos tinklalapyje (Support and credits – Feedback 

and support). 

6.2. Programos tinklapis 

 

Programos tinklalapio adresas http://web.uvic.ca/hrd/hotpot/ 

Papildoma informacija tinklalapyje patalpinta šiose skyriuose: 

 daţnai uţduodami klausimai (FAQ); 

 programos vartotojų forumas (Support); 

 mokomoji medţiaga (Tutorial) – informacinė medţiaga, metodinės 

rekomendacijos ir mokslo priemonės apie darbą su programa įvairiomis kalbomis– 

anglų, vokiečių, lenkų, estų, suomių, danų, italų, turkų, kinų, japonų ir rusų (Tutorial); 

 nuorodos į tinklalapius, kuruose patalpintos uţduotys įvairiomis kalbomis ir 

įvairių mokomųjų dalykų, sukurtos su programos Hot Potatoes (Hot Pot sites) pagalba.  

http://web.uvic.ca/hrd/hotpot/

